Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

About this document

Scope and purpose

This application note introduces you to the capabilities of the EZ-PD™ PMG1 (Power Delivery Microcontroller Gen1) family of high-voltage microcontrollers (MCU) with USB-C power delivery (PD) and helps you to get started with your first project with PMG1 MCU in Eclipse IDE for ModusToolbox™ software.

Intended audience

This is primarily intended for anyone who uses the EZ-PD™ PMG1 MCU family on ModusToolbox™ software.

Table of contents

About this document.................................................................................................................................................. 1
Table of contents........................................................................................................................................................ 1
1 Introduction ............................................................................................................................................................ 3
  1.1 PMG1 MCU family general description and comparison .......................................................... 3
  1.2 PMG1-S0 MCU ............................................................................................................................... 5
  1.3 PMG1-S1 MCU ............................................................................................................................... 6
  1.4 PMG1-S2 MCU ............................................................................................................................... 7
  1.5 PMG1-S3 MCU ............................................................................................................................... 8
  1.6 Software environment: ModusToolbox™ software ........................................................................... 9
2 Development ecosystem ...................................................................................................................................... 10
  2.1 PMG1 MCU resources .................................................................................................................... 10
  2.2 Firmware/application development using ModusToolbox™ software ........................................ 10
    2.2.1 PMG1 MCU software resources ............................................................................................. 12
    2.2.1.1 Configurators .................................................................................................................... 12
    2.2.1.2 PMG1 MCU software development ............................................................................... 13
  2.3 ModusToolbox™ software help ........................................................................................................ 14
  2.4 Support for other IDEs ..................................................................................................................... 14
  2.5 Programming and debugging ........................................................................................................... 14
  2.6 PMG1 MCU kits ............................................................................................................................. 14
3 My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software ........................................... 15
  3.1 Prerequisites ............................................................................................................................................. 15
    3.1.1 Hardware ....................................................................................................................................... 15
    3.1.2 Software ....................................................................................................................................... 15
  3.2 Application development flow ................................................................................................................ 15
  3.3 About the design ..................................................................................................................................... 15
  3.4 Procedure ................................................................................................................................................ 16
    3.4.1 Part 1: Create a new application ............................................................................................... 16
    3.4.2 Part 2: View and modify the design ............................................................................................ 18
    3.4.3 Part 3: Write the firmware .......................................................................................................... 21
    3.4.3.1 Firmware flow ..................................................................................................................... 21
### Table of contents

3.4.4 Part 4: Build the application .................................................................................................................. 23  
3.4.5 Part 5: Program the device ...................................................................................................................... 25  
3.4.6 Part 6: Test your design .......................................................................................................................... 27  
3.4.7 Part 7: Debug the application .................................................................................................................. 29  
3.4.7.1 Debugging through the KitProg3 interface ....................................................................................... 29  
3.4.7.2 Debug through the 10-pin SWD header ............................................................................................ 32  
3.5 Add middleware ........................................................................................................................................ 33  
3.6 USB-PD sink example .................................................................................................................................. 33  
3.7 Porting the project across PMG1 MCUs ..................................................................................................... 34  
4 Summary ...................................................................................................................................................... 37  

**Related documents** .................................................................................................................................... 38  
**Acronyms and abbreviations** ..................................................................................................................... 39  
**Glossary** ..................................................................................................................................................... 40  
**Revision history** .......................................................................................................................................... 41
Introduction

1. **PMG1 MCU family general description and comparison**

EZ-PD™ PMG1 (Power Delivery Microcontroller Gen1) is a family of high-voltage USB power delivery (PD) microcontrollers (MCU). These chips include an Arm® Cortex® -M0/M0+ CPU and USB PD controller along with analog and digital peripherals. PMG1 MCU is targeted for embedded systems that provide/consume power to/from a high-voltage USB PD port and leverages the microcontroller to provide additional control capability.

**Table 1** shows the comparison of features of different MCUs of the PMG1 MCU family. This table can be used to select the suitable PMG1 MCU for your application.

<table>
<thead>
<tr>
<th>Subsystem or range</th>
<th>Item</th>
<th>PMG1-S0</th>
<th>PMG1-S1</th>
<th>PMG1-S2</th>
<th>PMG1-S3</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU and memory subsystem</td>
<td>Core</td>
<td>Arm® Cortex®-M0</td>
<td>Arm® Cortex®-M0</td>
<td>Arm® Cortex®-M0+</td>
<td>Arm® Cortex®-M0+</td>
</tr>
<tr>
<td></td>
<td>Max freq (MHz)</td>
<td>48</td>
<td>48</td>
<td>48</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Flash (KB)</td>
<td>64</td>
<td>128</td>
<td>128</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>SRAM (KB)</td>
<td>8</td>
<td>12</td>
<td>8</td>
<td>32</td>
</tr>
<tr>
<td>Power Delivery</td>
<td>Power Delivery ports</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1 port in 48QFN 2 ports in 97BGA</td>
</tr>
<tr>
<td></td>
<td>Role</td>
<td>Sink</td>
<td>DRP</td>
<td>DRP</td>
<td>DRP</td>
</tr>
<tr>
<td></td>
<td>MOSFET gate drivers</td>
<td>1x PFET</td>
<td>2x PFET</td>
<td>2x NFET</td>
<td>Flexible 2x NFET</td>
</tr>
<tr>
<td></td>
<td>Fault protection</td>
<td>VBUS OVP and UVP</td>
<td>VBUS OVP, UVP and OCP. SCP and RCP (Source only)</td>
<td>VBUS OVP, UVP and OCP</td>
<td>VBUS OVP, UVP and OCP. SCP and RCP (Source only)</td>
</tr>
<tr>
<td>USB</td>
<td>Integrated Full Speed USB 2.0 device with Billboard Class support</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Voltage range</td>
<td>Supply (V)</td>
<td>VDDD (2.7–5.5)</td>
<td>VSYS (2.75–5.5)</td>
<td>VSYS (2.7–5.5)</td>
<td>VSYS (2.8–5.5)</td>
</tr>
<tr>
<td></td>
<td>I/O (V)</td>
<td>1.71–5.5</td>
<td>1.71–5.5</td>
<td>1.71–5.5</td>
<td>1.71–5.5</td>
</tr>
<tr>
<td>Digital</td>
<td>SCB (configurable as I2C/UART/SPI)</td>
<td>2</td>
<td>4</td>
<td>4</td>
<td>7 in 48QFN (out of which only 5 can be configured as SPI and UART) 8 in 97BGA</td>
</tr>
<tr>
<td></td>
<td>TCPWM block (configurable as timer, counter or)</td>
<td>4</td>
<td>2</td>
<td>4</td>
<td>7 in 48QFN 8 in 97BGA</td>
</tr>
</tbody>
</table>
## Introduction

<table>
<thead>
<tr>
<th>Subsystem or range</th>
<th>Item</th>
<th>PMG1-S0</th>
<th>PMG1-S1</th>
<th>PMG1-S2</th>
<th>PMG1-S3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>pulse width modulator)</td>
<td></td>
<td></td>
<td>Yes (AES-128, SHA2-256, SHA1,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SHA2-224, SHA2-256, PRNG, CRC)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hardware Authentication Block (Crypto)</td>
<td>No</td>
<td>No</td>
<td>Yes (AES-128, SHA2-256, TRNG,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Vector Unit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ADC</td>
<td>2x 8-bit SAR</td>
<td>1x 8-bit SAR</td>
<td>2x 8-bit SAR</td>
<td>2x 8-bit SAR 1x 12-bit SAR</td>
</tr>
<tr>
<td></td>
<td>On-chip temperature sensor</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>DMA</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Max # of I/O</td>
<td>12 (10+2 OVT)</td>
<td>17 (15+2 OVT)</td>
<td>20 (18+2 OVT)</td>
<td>26 (24+2 OVT) in 48QFN | 50 (48+2 OVT) in 97BGA</td>
</tr>
<tr>
<td></td>
<td>Charging source</td>
<td>-</td>
<td>BC 1.2, AC</td>
<td>BC 1.2, AC</td>
<td>BC 1.2, AC, AFC and Quick Charge 3.0</td>
</tr>
<tr>
<td></td>
<td>Charging sink</td>
<td>BC 1.2, Apple Charging (AC)</td>
<td>BC 1.2, AC</td>
<td>BC 1.2, AC</td>
<td>BC 1.2, AC</td>
</tr>
<tr>
<td></td>
<td>ESD protection</td>
<td>Yes (Up to ±8-kV contact discharge and up to ±15-kV air discharge, HBM, CDM)</td>
<td>Yes (HBM and CDM)</td>
<td>Yes (Up to ±8-kV contact discharge and up to ±15-kV air discharge, HBM, CDM)</td>
<td>Yes (HBM and CDM)</td>
</tr>
<tr>
<td></td>
<td>Package options</td>
<td>24 QFN (4x4 mm, 0.5-mm pitch)</td>
<td>40 QFN (6x6 mm, 0.5-mm pitch)</td>
<td>40 QFN (6x6 mm, 0.5-mm pitch)</td>
<td>48QFN (6x6 mm, 0.5-mm pitch) | 97BGA (6x6 mm, 0.5-mm and 0.65-mm pitch)</td>
</tr>
</tbody>
</table>
Introduction

1.2 PMG1-S0 MCU

PMG1-S0 MCU is the first member of the PMG1 MCU family. It includes a 48-MHz Arm® Cortex®-M0 processor with 64-KB flash, a complete Type-C USB-PD transceiver, pull-down termination resistor $R_D$ to support Sink on a Type-C port, 12 GPIOs, and system-level ESD protection. It is available in a 24-pin QFN package.

![PMG1-S0 MCU block diagram](image-url)
Introduction

1.3 PMG1-S1 MCU

PMG1-S1 MCU includes a 48-MHz Arm® Cortex®-M0 processor but with a higher flash size than PMG1-S0 MCU. It has 128-KB flash, a complete Type-C USB PD transceiver with all termination resistors $R_P$, $R_D$, and dead battery $R_D$, and 17 GPIOs. It is available in a 40-pin QFN package.

---

**Figure 2** PMG1-S1 MCU block diagram
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Introduction

1.4 PMG1-S2 MCU

PMG1-S2 MCU uses the 48-MHz Arm® Cortex®-M0 processor with 128-KB flash and includes a Full Speed USB device controller, a Crypto engine for authentication, 20 GPIOs and system level ESD protection. PMG1-S2 MCU is available in 40-QFN package.

![PMG1-S2 MCU block diagram](image)

**Figure 3** PMG1-S2 MCU block diagram
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Introduction

1.5 PMG1-S3 MCU

PMG1-S3 MCU uses the 48-MHz Arm® Cortex®-M0+ processor with 256-KB flash and includes a Full Speed USB device controller, CAPSENSE™, DMA, a Crypto engine for authentication, 26/50 GPIOs, and system-level ESD protection. PMG1-S3 MCU is available in 48-QFN and 97-BGA package.

Figure 4  PMG1-S3 MCU block diagram
Introduction

1.6 Software environment: ModusToolbox™ software

The ModusToolbox™ software environment supports PMG1 MCU application development with a set of tools for configuring the device, setting up peripherals, and complementing your projects with world-class middleware.

This application note gives an overview of the ModusToolbox™ development ecosystem and gets you started with a simple ‘Hello World’ application. The detailed steps to create the application from an empty template application will be described in the following sections.
2 Development ecosystem

2.1 PMG1 MCU resources

The PMG1 MCU family has a rich set of documentation, development tools, and online resources to assist you during your development process. The following is an abbreviated list of resources for PMG1 MCU. Visit PMG1 MCU webpage to find out more.

- PMG1 MCU webpage
- Datasheets provide all the information needed to select and use a particular device, including functional description and electrical specifications.
- Application notes and code examples cover a broad range of topics, from basic to advanced level.
- Technical reference manuals (TRMs) provide detailed descriptions of the architecture and registers in each device family.
- Prototyping kits are available for evaluation, design, and development of different applications using PMG1 MCUs.
- Technical support: PMG1 MCU community forum, knowledge base articles

2.2 Firmware/application development using ModusToolbox™ software

ModusToolbox™ development platform used for firmware/application development with the PMG1 MCU. This latest-generation toolset, includes the Eclipse IDE and therefore is supported across Windows, Linux, and macOS platforms. The ModusToolbox™ software includes configurators, low-level drivers, middleware libraries, as well as other packages that enable you to create your PMG1 MCU applications. Using the configurators, you can set the configuration of different blocks in the device and generate code that can be used in firmware development.

The Eclipse IDE for ModusToolbox™ is integrated with quick launchers for tools and design configurators in the Quick Panel. ModusToolbox™ also supports third-party IDEs, including Visual Studio Code, Arm® MDK (µVision), and IAR Embedded Workbench.

A high-level view of the tools/resources included in the ModusToolbox™ software is shown in Figure 5. For a more in-depth overview of the ModusToolbox™ software, see ModusToolbox™ software user guide.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Development ecosystem

Embedded PMG1 MCU is the native development flow supported by the Eclipse IDE for ModusToolbox™ software for PMG1 MCU. You can use it on the bare metal or with an RTOS of your choosing.

Following are the low-level resources for PMG1 MCU.

1. **Board Support Packages (BSP):** A BSP is the layer of firmware containing board-specific drivers and other functions. The board support package is a set of libraries that provide APIs to initialize the board and provide access to board-level peripherals. It includes low-level resources such as Peripheral Driver Library (PDL) for PMG1 MCU and has macros for board peripherals. Custom BSPs can be created to enable support for end-application boards. See the Board support Packages section in ModusToolbox™ software user guide for more information.

2. **Peripheral Driver Library (PDL):** The PDL integrates device header files, start-up code, and peripheral drivers into a single package. The drivers abstract the hardware functions into a set of easy-to-use APIs. This reduces the need to understand register usage and bit structures, thus easing software development for the extensive set of peripherals in the PMG1 MCU series. You configure the driver for your application, and then use API calls to initialize and use the peripheral. For a PMG1 MCU solution, the on-chip blocks including USBPD and SCBs are controlled by the MTB CAT2 PDL.

3. **Middleware:** The middleware is a set of firmware modules that provide specific capabilities to an application. PDStack is the middleware available for PMG1 MCU, which contains the Type-C and USB-PD state machine implementations, the PD protocol, and PD Policy Manager blocks.

All low-level resources are delivered as libraries via GitHub repositories.

Figure 6 shows the blocks of ModusToolbox™ software which are relevant for PMG1 MCU.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Development ecosystem

Figure 6  ModusToolbox™ software for PMG1 MCU

2.2.1  PMG1 MCU software resources

The PMG1 MCU software resources include configurators, drivers, libraries, and middleware, as well as Makefiles and scripts to get you started with developing firmware with PMG1 MCU.

2.2.1.1  Configurators

ModusToolbox™ software provides graphical applications called Configurators that make it easier to configure a hardware block or middleware. For example, instead of having to search through all the documentation to configure a serial communication block as a UART with a desired configuration, open the Configurator and set the baud rate, parity, and stop bits. Upon saving the hardware configuration, the tool generates the C code to initialize the hardware with the desired configuration.

Configurators are independent of each other, but they can be used together to provide flexible configuration options. They can be used standalone, in conjunction with other tools, or within a complete IDE. Configurators are used for:

- Setting options and generating code to configure drivers
- Setting up connections such as pins and clocks for a peripheral
- Setting options and generating code to configure middleware

For PMG1 MCU applications, available configurators include the following:

- **Device Configurator**: Set up the system (platform) functions, as well as the basic peripherals (e.g., UART, Timer, PWM).
- **EZ-PD™ Configurator**: Provides a user-friendly tool for selecting the features of PDStack middleware and configuring parameters to generate the required code.

These configurators create their own files (e.g., design.mtbezpd for EZ-PD™ Configurator). The configurator file (design.modus) usually provided with the BSP and design.mtbezpd is provided as part of the code example. When an application is created based on a BSP, the files are copied into the application. You can also create custom device configurator files for an application and override the ones provided by the BSP. For more details
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Development ecosystem

refer to Documentation section in the ModusToolbox™ tool page. These documents can also be accessed in ModusToolbox™ via help menu > ModusToolbox™ General Documentation > ModusToolbox™ Documentation Index.

2.2.1.2 PMG1 MCU software development

Infineon provides customers with source code and tools to enable software development for PMG1 MCUs. You use tools to specify how you want to configure the hardware, generate code for that purpose which you use in your firmware, and include various middleware libraries for additional functionality, like PDStack. This source code makes it easier to develop the firmware for supported devices. It helps you quickly customize and build firmware without the need to understand the register set.

As Figure 7 shows, with the Eclipse IDE for ModusToolbox™ software, you can:

1. Choose a board support package (BSP).
2. Create a new application based on a list of template applications, filtered by kit.
3. Add middleware.
4. Develop your application firmware using the PDL.

Figure 7 Eclipse IDE for ModusToolbox™ software resources and middleware
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

Development ecosystem

2.3 ModusToolbox™ software help

Visit the ModusToolbox™ software home page to download and install the latest version of ModusToolbox™ software. Launch Eclipse IDE for ModusToolbox™ software and navigate to the following items for ModusToolbox™ Help.

Choose Help > ModusToolbox™ General Documentation or Help > Eclipse IDE for ModusToolbox™ Documentation

2.4 Support for other IDEs

You can develop firmware for PMG1 MCUs using your favourite IDE such as IAR Embedded Workbench or Visual Studio Code in addition to the Eclipse IDE.

See the “Exporting to IDEs” section in ModusToolbox™ software user guide for more details. Infineon recommends that you generate resource configurations using the configuration tools provided with ModusToolbox™ software.

2.5 Programming and debugging

The Eclipse IDE of ModusToolbox™ software supports KitProg3 and uses the Open On-Chip Debugger (OpenOCD) protocol for debugging PMG1 MCU applications. It also supports GDB (GNU Debugger) debugging using industry standard probes like the Segger J-Link.

All PMG1 MCU kits have a KitProg3 onboard programmer/debugger. It supports Cortex® Microcontroller Software Interface Standard - Debug Access Port (CMSIS-DAP). See the KitProg3 user guide for details.

For more information on programming/debugging firmware on PMG1 devices with ModusToolbox™ software, see the “Program and Debug Support” section in the ModusToolbox™ software user guide.

2.6 PMG1 MCU kits

Table 2 lists the list of PMG1 MCU kits and the corresponding BSPs.

<table>
<thead>
<tr>
<th>PMG1 MCU</th>
<th>PMG1 MCU Kit</th>
<th>BSP</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYPM1011-24LQXI</td>
<td>CY7110 EZ-PD™ PMG1-S0 prototyping kit</td>
<td>PMG1-CY7110</td>
</tr>
<tr>
<td>CYPM1111-40LQXI</td>
<td>CY7111 EZ-PD™ PMG1-S1 prototyping kit</td>
<td>PMG1-CY7111</td>
</tr>
<tr>
<td>CYPM1211-40LQXI</td>
<td>CY7112 EZ-PD™ PMG1-S2 prototyping kit</td>
<td>PMG1-CY7112</td>
</tr>
<tr>
<td>CYPM1311-48LQXI</td>
<td>CY7113 EZ-PD™ PMG1-S3 prototyping kit</td>
<td>PMG1-CY7113</td>
</tr>
<tr>
<td>CYPM1322-97BZXI</td>
<td>NA</td>
<td>CYPM1322-97BZXI</td>
</tr>
</tbody>
</table>
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

3 My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

This section does the following:

- Demonstrate how to create a simple PMG1 MCU-based design, and build and program it on to the prototyping kit.
- Make it easy to learn PMG1 MCU design techniques and how to use the Eclipse IDE for ModusToolbox™ software.

3.1 Prerequisites

Before you get started, make sure that you have the appropriate kit for your PMG1 MCU product line and have installed the latest ModusToolbox™ software from PMG1 MCU webpage. You also need internet access to get the GitHub repositories during project creation.

See Table 2 for the list of PMG1 MCU kits.

3.1.1 Hardware

The design is developed for CY7110 EZ-PD™ PMG1-S0 prototyping kit (PMG1-CY7110). However, you can build the projects for other prototyping kits. See the Application development flow section.

3.1.2 Software

- ModusToolbox™ software 2.3 or above

After installing the software, see the ModusToolbox™ software user guide to get an overview of the software.

3.2 Application development flow

These instructions are grouped into several sections. Each section is devoted to a phase of the application development workflow. The major sections are:

- Part 1: Create a new application
- Part 2: View and modify the design
- Part 3: Write the firmware
- Part 4: Build the application
- Part 5: Program the device
- Part 6: Test your design
- Part 7: Debug the application

The code described in the sections that follow has been tested on all the PMG1 MCU kits listed in Table 2.

3.3 About the design

This design uses the PMG1-S0 MCU to execute two tasks: UART communication and LED control. The project uses the UART to print a “Hello World” message to the serial port stream, and starts blinking the user LED on the kit.
3.4 Procedure

3.4.1 Part 1: Create a new application

This section takes you on a step-by-step guided tour of the new application creation process. It uses the “Hello World” code example and guides you through the design development stages, and programming.

If you are familiar with developing projects with ModusToolbox™ software, you can use the code example directly. It is a complete design, with all the firmware written for the supported kits. You can walk through the instructions in the code and observe how the steps are implemented.

If you start from scratch and follow all the instructions in this section, you use the code example as a reference while following the instructions.

1. Launch Eclipse IDE for ModusToolbox™ software.

   Launch Eclipse IDE for ModusToolbox™ software 2.3 to get started. Note that Eclipse IDE for ModusToolbox™ software needs access to the internet to successfully clone the template application onto your machine.

2. Select a new workspace.

   At launch, Eclipse IDE for ModusToolbox™ presents a dialog box to choose a directory for use as the workspace directory. The workspace directory is used to store workspace preferences and development artefacts. You can choose an existing empty directory by clicking the Browse button, as Figure 8 shows. Alternatively, you can type in a directory name to be used as the workspace directory along with the complete path, and Eclipse IDE will create the directory for you.

   ![Figure 8 Select/create a directory for the workspace](image)

3. Create a new ModusToolbox™ application.
   a) Click New Application in the Start group of the Quick Panel.
   b) Alternatively, you can choose File > New > ModusToolbox™ Application, as Figure 9 shows.

      The Eclipse IDE for ModusToolbox™ Application window appears.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

4. Select a target PMG1 MCU kit.
   a) In the Choose Board Support Package (BSP) dialog, choose the Kit Name that you have. As you are creating for PMG1-S0, choose PMG1-CY7110. See Figure 10 for help with this step.
   b) Click Next.

   c) In the Select Application dialog, select Hello World template application, as Figure 11 shows.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

d) In the Name field, type in a name for the application, such as PMG1_S0_Hello_World. You can choose to leave the default name if you prefer.

e) Click Create to create the application and wait for the Project Creator to automatically close once the project is successfully created.

![Figure 11](Image)

Choose the template application

You have successfully created a new ModusToolbox™ software application for PMG1-S0 MCU. The BSP uses the CYPM1011-24LQXI device on the CY7110 EZ-PD™ PMG1-S0 prototyping kit (PMG1-CY7110).

README.md file will be opened after the application is created successfully, which contains information about the template application implementation.

If you are using custom hardware based on PMG1-S0 MCU, or a different PMG1 MCU part number, see the “Creating your Own BSP” section in the ModusToolbox™ software user guide (Help > ModusToolbox™ General Documentation).

3.4.2 Part 2: View and modify the design

Figure 12 shows the ModusToolbox™ software project explorer interface displaying the structure of the application project.

In the Eclipse IDE for ModusToolbox™ software, a PMG1 MCU application consists of a project to develop code for the CM0/CM0+ CPU. A project folder consists of various subfolders – each denoting a specific aspect of the project.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

a) An application project contains a Makefile which is typically at the root folder. It has instructions on how to recreate the project. This file also contains the set of directives that the make tool uses to compile and link the application project. There can be more than one project in an application; each dependent project usually resides within its own folder within the application folder and contains its own Makefile.

b) The build folder contains all the artefacts resulting from the make build of the project. The output files are organized by target BSPs.

c) The deps folder contains .mtb files, which provide the location from which ModusToolbox™ software pulls the BSP/library that is directly referenced by the application. These files typically contain the GitHub location of the entire library. The .mtb files also contain a git Commit Hash or Tag that tells which version of the library is to be fetched and a path as to where the library should be stored.

d) The libs folder also contains .mtb files; these point to libraries that are included indirectly as a dependency of a BSP or another library. For each indirect dependency, the Library Manager places an .mtb file in this folder. These files have been populated based on the targets available in deps folder.

For example, using the BSP lib file TARGET_PMG1-CY7110.mtb populates the libs folder with the following .mtb files: core-lib.mtb, core-make.mtb, mtb-hal-cat2.mtb, mtb-pdl-cat2.mtb, recipe-make-cat2.mtb.

The libs folder contains mtb.mk file, which stores the relative paths of all the libraries required by the application. The build system uses this file to find all the libraries required by the application.

e) By default, when creating a new application or adding a library to an existing application and specifying it as shared, all libraries are placed in an mtb_shared directory adjacent to the application directory.

The mtb_shared folder is shared between different applications that use the same versions of BSP/library.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

f) The files provided by the BSP are listed under the TARGET_x folder. All the configuration files generated by the device and peripheral configurators are included in the GeneratedSource folder of the BSP and are prefixed with cycfg_. These files contain the design configuration as defined by the BSP. You can view and modify the design configuration by clicking the Device Configurator link in the Quick Panel. However, note that if you upgrade the BSP library to a newer version, the manual edits done to the design.x files are lost.

Of interest are the configuration files that are in the COMPONENT_BSP_DESIGN_MODUS folder. Click on the Device Configurator link in the Quick Panel. Figure 13 shows the resulting window called the Device Configurator window. You can also double-click to open the other design.x files to open the respective configurators or click the corresponding links in the Quick Panel.

![Figure 13](design.modus overview)

The Device Configurator window provides a Resources Categories pane. Here, you can choose between different resources available in the device such as peripherals, pins, and clocks from the List of Resources.

You can choose how a resource behaves by choosing a Personality for the resource. For example, a Serial Communication Block (SCB) resource can have an EZI2C, I2C, SPI or UART personalities. The Name is your name for the resource, which is used in firmware development. One or more names can be specified by using a comma to separate them (with no spaces)

The Parameters pane is where you enter the configuration parameters for each enabled resource and the selected personality. The Code Preview pane shows the configuration code generated per the configuration parameters selected. This code is populated in the cycfg_ files in the GeneratedSource folder. Any errors, warnings, and information messages arising out of the configuration are displayed in the Notices pane.

At this point in the development process, you are ready to add any required middleware to the design. Figure 28 shows an example of adding a middleware. For the “Hello World” example project, no additional middleware needs to be added.

The configuration of the debug UART peripheral, pins, and system clocks can be done directly in the code using the function APIs provided by BSP. See Part 3: Write the firmware.
3.4.3 Part 3: Write the firmware

At this point in the development process, you have created an application, with the assistance of a template application. In this section, you write the firmware that implements the design functionality.

If you are working from scratch, you can copy the source code provided in this section to the `main.c` of the application project. If you are using the PMG1 MCU ‘Hello World’ code example, all the required files are already in the application.

3.4.3.1 Firmware flow

You now examine the code in the `main.c` file of the application. Figure 14 shows the firmware flowchart.

Resource initialization for this example is performed by the CM0 CPU. It configures the system clocks, pins, clock to peripheral connections, and other platform resources.

When the CM0 CPU is enabled, the clocks and system resources are initialized by the BSP initialization function. The UART peripheral is configured and enabled. It prints a “Hello World” message on the terminal emulator. The CPU continuously toggles the LED state with a delay of 500 milliseconds.

Note that the application code uses BSP/middleware functions to execute the intended functionality.

Copy the following code snippet to `main.c` of your application project.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

```c
/**************************************************************
 * Include header files
 ***************************************************************/
#include "cy_pd1.h"
#include "cybsp.h"

/**************************************************************
 * Macros
 ***************************************************************/
#define LED_DELAY_MS (500u)
#define CY_ASSERT_FAILED (0u)

/** Function Name: main
 * int main(void)
 */
int main(void)
{
  cy_rslt_t result;
  cy_stc_scb_uart_context_t CYESP_UART_context;

  /* Initialize the device and board peripherals */
  result = cybsp_init();

  /* Board init failed. Stop program execution */
  if (result != CY_RSLT_SUCCESS)
  {
    CY_ASSERT(CY_ASSERT_FAILED);
  }

  /* Configure and enable the UART peripheral */
  Cy_SCB_UART_Init(CYESP_UART_HW, &CYESP_UART_config, &CYESP_UART_context);
  Cy_SCB_UART_Enable(CYESP_UART_HW);

  /* Enable global interrupts */
  __enable_irq();

  /* send a string over serial terminal */
  Cy_SCB_UART_Printf(CYESP_UART_HW, "Hello world\r\n");

  for(;;)
  {
    /* Toggle the user LED state */
    Cy_GPIO_Init(CYESP_FW_LED_PORT, CYESP_FW_LED_PIN);
    Cy_GPIO_Toggle(CYESP_FW_LED_PIN);
    Cy(SYSLIB_Delay(LED_DELAY_MS);
  } 

  /* [] END OF FILE */
```
This completes the summary of how the firmware works in the code example. Feel free to explore the source files for a deeper understanding.

### 3.4.4 Part 4: Build the application

This section shows how to build the application.

1. Build the application.
   a) Select the application project in the Project Explorer window and click on the **Build <name> Application** shortcut under the `<name>` group in the Quick Panel. It selects the **Debug** build configuration and compiles/links all projects that constitute the application.
   b) The **Console** view lists the results of the build operation, as **Figure 15** shows.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Figure 15  Build the application

If you encounter errors, try the following options:

- Revisit earlier steps to ensure that you accomplished all the required tasks.
- Check the Problems tab to find more details about the errors and to solve them.
- From Quick Panel, click 'Clean <application name>' after which try to build the project again.

Note: You can also use the command line interface (CLI) to build the application. Please refer to Using the Command Line section in the ModusToolbox™ software user guide. This document can also be accessed in ModusToolbox™ software via help menu > ModusToolbox™ General Documentation.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

3.4.5 Part 5: Program the device

This section explains how to program the device. Refer Figure 16 for CY7110 EZ-PD™ PMG1-S0 prototyping kit. See the ‘Kits’ section in the PMG1 MCU web page.

![Diagram of CY7110 EZ-PD™ PMG1-S0 prototyping kit](image)

1. KitProg3 USB Type-C port (J1)
2. KitProg3 status LED (LED1)
3. PSoc™ 5LP controller (U1)
4. KitProg3 mode switch (SW1)
5. KitProg3 VBUS LED (LED2)
6. KitProg3 header (J3, J4) *
7. Power selection jumper (J5)
8. User LED (LED3)
9. I/O headers (J6, J7) *
10. CYPM1011-24LQXI (PMG1-S0)
11. User switch (SW2)
12. 3.3V on-board LDO
13. 10-pin SWD/JTAG header *
14. DC_OUT terminal block (J9)
15. Load switch
16. PMG1 MCU USB Type-C port (J10)

* Footprint only; not populated on the board.

Figure 16 Choose CY7110 EZ-PD™ PMG1-S0 prototyping kit

ModusToolbox™ software uses the OpenOCD protocol to program and debug applications on PMG1 MCU devices. For ModusToolbox™ software to identify the device on the kit, the kit must be running KitProg3.

If you are using a PMG1 MCU prototyping kit with a built-in programmer, follow steps 1 and 2.

If you are developing on your own hardware, you may need a hardware programmer/debugger; for example, an Infineon CY8CKIT-005 MiniProg4.

1. Make the following hardware connections on the prototyping kit:
   a) Connect a Type-C cable from the J1 (KitProg3 USB Type-C port) connector on the kit to the host.
   b) Connect the J5 (power selection jumper) pins 2 and 3 for programming mode.

   Note: Device can also be programmed by connecting J5 (power selection jumper) pins 1 and 2 for operation mode, and connecting both Type-C cables J1 and J10.

2. Program the board:
   a) In ModusToolbox™ software, select the application project in the Project Explorer.
   b) In the Quick Panel, scroll down, and click `<Application Name> Program (KitProg3_MiniProg4).`
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

The IDE will select and run the appropriate run configuration. Note that this step will also perform a build if any files have been modified since the last build.

Figure 17 Programming an application to a device

3. The Console view in the ModusToolbox™ software lists the results of the programming operation, as Figure 18 shows.

Figure 18 Console – programming results
**3.4.6 Part 6: Test your design**

This section explains how to test your design.

1. Make the following hardware connections:
   a) Connect the J5 (Power Selection Jumper) pins 1 and 2 for operational mode.
   b) Connect J6.10 to J3.8 and J6.9 to J3.10 to establish a UART connection between KitProg3 and PMG1-S0.

   **Note:** *This step to establish UART connection needs to be executed only for the following older revision of the kit boards:*

   - CY7110 board revision 3 or lower
   - CY7111 board revision 2 or lower
   - CY7112 board revision 2 or lower
   - CY7113 board revision 3 or lower

   The kit revision number (600-60xxx-01 Revxx) is marked on the silkscreen of the kit board as shown:

   ![Identifying PMG1 MCU kit board revision number](image)

2. Open a terminal program and select the KitProg3 COM port. This application note uses Tera Term as the UART terminal emulator to view the results. You can use any terminal of your choice to view the output.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

3. Set the serial port parameters to 8N1 and 115200 baud.

4. Connect a Type-C cable from the J10 (PMG1 MCU USB Type-C Port) connector to the host.
5. Confirm that "Hello World" is displayed on the UART terminal.
6. Confirm that the Power LED (LED4) glows green and User LED (LED3) blinks green.

3.4.7 Part 7: Debug the application

Eclipse IDE for ModusToolbox™ software can be used to debug applications. The prototyping kits can be acquired in debug mode though either of the following three interfaces similar to programming mode:

- KitProg3 USB Type-C port
- 10-pin SWD header
- I/O header pins

The kit needs to be configured for operational mode before starting the debug.

3.4.7.1 Debugging through the KitProg3 interface
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Do the following to debug an application on the CY7111 and CY7112 prototyping kits over KitProg3 interface from Eclipse IDE for ModusToolbox™ software.

1. Open the Eclipse IDE for ModusToolbox™ software and select the PMG1 MCU project on the host PC. For details, see the Eclipse IDE for ModusToolbox™ software user guide.
2. Place the jumper shunt on pins 1–2 of the power section jumper (J5) to configure the kit in operational mode.
3. Connect the jumper shunt on pins 1–2 of the power section jumper (J5) to configure the kit in operational mode.
4. Connect the USB-PD sink port to the USB PD source to activate on-board LDO, Load switch, and user LED. Ensure that LED4, which is power LED, glows green.
5. Go to the Quick Panel tab. Click <Application name> Debug (KitProg3_MiniProg4) from the Launches section.
6. The IDE will switch to debugging mode and will halt at the first line of the main () function. This indicates that the application is ready for debugging.

Do the following to debug an application on the CY7110 prototyping kits over KitProg3 interface from Eclipse IDE for ModusToolbox™ software.

1. Open the Eclipse IDE for ModusToolbox™ software and select the PMG1 MCU project on the host PC or laptop. For details, see the Eclipse IDE for ModusToolbox™ software user guide.
2. Power selection jumper (J5) shunt needs to be placed on pins 2–3 of the power selection jumper (J5) to enable ModusToolbox™ software to acquire the target (PMG1-S0) in power cycle mode.
3. Connect the USB-PD sink port to the USB PD source to activate on-board LDO, Load switch, and user LED. Ensure that LED4, which is power LED, glows green.
4. Connect the kit to the host PC through programming KitProg3 USB Type-C Port. Ensure that LED1 and LED2 glow amber. LED2, which is KitProg3 Power LED, indicates that the KitProg3 module is powered. LED1, which is the status LED, indicates the programming/debug mode and status, and is ON when KitProg3 is powered.
5. Go to the Quick Panel tab. Click <Application name> Program (KitProg3_MiniProg4) from the Launches section to download the firmware into the kit as shown in Figure 24.
6. After program download completed, change the jumper to short 1–2 of the power section jumper (J5) to configure the kit in operational mode for debugging.
7. Go to Run menu, click on Debug Configurations, as shown in in Figure 25.
8. Under GDB OpenOCD Debugging, select <Application name> Attach (KitProg3_MiniProg4) and click on Debug as shown in Figure 26. This will start a debugging session attaching to a running target without programming or reset. For more information on debug configurations refer ModusToolbox™ software user guide.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Figure 24  Quick panel and debug options

Figure 25  Selecting Debug configurations from the Run menu
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Figure 26  Selecting Debug Attach and starting a debug session

On successful completion of compilation, build and debug launch, ModusToolbox™ software acquires the kit in debug mode and the debug tools appear on the toolbar.

3.4.7.2  Debug through the 10-pin SWD header

Figure 27  Debugging through the 10-pin SWD header
My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Figure 27 shows the setup for debugging prototyping kits through 10-pin SWD connector. The procedure to use Eclipse IDE for ModusToolbox™ software is the same as that of the KitProg3 interface. Follow steps 5 to 7 listed in Debugging through the KitProg3 interface.

3.5 Add middleware

This section explains the steps to add middleware to your active application using the Library Manager. For the ‘Hello World’ example project, no additional middleware needs to be added.

The initialization of the middleware will be done in the main.c code.

1. In the Quick Panel, click on the Library Manager link.
2. In the subsequent dialog, select the Libraries tab.
3. Under Board Utils or MCU Middleware, select and enable the required middleware.
4. Click Update.

The files necessary to use the middleware are added in the mtb_shared folder as well as in the .mtb file under the deps folder. Figure 28 shows an example of adding a middleware. The .mtb file pointing to the PDStack middleware is added to the application project. The middleware content is also downloaded and placed inside the corresponding folder called pdstack.

![Figure 28: Add PDStack middleware in a ModusToolbox™ software application](image)

3.6 USB-PD sink example

A code example for USBPD Sink can also be found in the Select Application dialog, select “USBPD_Sink” template application.

The PMG1 MCU devices support a USB-PD block which integrates the Type-C terminations, comparators and Power Delivery Transceiver required to detect the attachment of a partner device and negotiate power contracts with them.

This application uses the PDStack in an UFP (Upstream Facing Port) - Sink configuration. The PMG1 MCU devices have a dead-battery Rd termination which ensures that a USB-C source/charger connected to it can detect the presence of a sink even when the PMG1 MCU device is not powered.
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

The application tries to keep the PMG1 MCU device in deep sleep state where all clocks are disabled and only limited hardware blocks are enabled, for most of its working time. Interrupts in the USB-PD block are configured to detect any changes that happen while the device is in sleep and wake it up for further processing.

An Over-Voltage (OV) comparator in the USB-PD block is used to detect cases where the power source is supplying incorrect voltage levels and automatically shut-down the power switches to protect the rest of the components on the board.

README.md file will be opened after the application is created successfully, which contains information about the template application implementation.

3.7 Porting the project across PMG1 MCUs

The project created for one MCU can be ported to work for other MCUs of the PMG1 MCU family. With a consideration that the feature / functionality / resource we are porting is available in the new MCU. Please refer below steps for porting the project across PMG1 MCUs.

1. Open the Library Manager from the Quick Link.
2. Do the following in the Library Manager:
   a) Select the new BSP to add it and deselect the current one to remove it. In Figure 29, you can see that PMG1-CY7110 is deselected and PMG1-CY7111 is selected. This means that you are porting the PMG1 MCU ‘Hello World’ code example to PMG1-S1 MCU.

   Note: To port the “Hello World” example to a custom hardware, choose the custom BSP that has been created.

   b) Click Update.

Figure 29 Porting a project to a different BSP
Getting started with EZ-PD™ PMG1 MCU on ModusToolbox™ software

My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

3. In the Makefile, change the target name to that of the new BSP selected in previous step. See Figure 30.

![Figure 30 Edit the target name]

4. Do the following in the Quick Panel:
   a) Click on Generate Launches for <project name>.
   b) Click on Refresh Quick Panel.

![Figure 31 Regenerate launch configurations]

Now, the Device Configurator is updated to the new BSP, as shown in Figure 32.
My first PMG1 MCU design using Eclipse IDE for ModusToolbox™ software

Figure 32  Device configurator with new BSP

5. Continue with rest of the development steps from Application development flow to build, program and test the project.
Summary

4 Summary

This application note explored the PMG1 MCU device architecture and the associated development tools. PMG1 MCU is a programmable embedded system-on-chip with configurable analog and digital peripheral functions, memory, and CM0/CM0+ CPU system.
Related documents

For a complete and updated list of PMG1 MCU code examples, visit our GitHub repository. For more PMG1 MCU-related documents, visit the PMG1 MCU product web page.
## Acronyms and abbreviations

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Apple Charging</td>
</tr>
<tr>
<td>AES</td>
<td>Advanced Encryption Standard</td>
</tr>
<tr>
<td>AFC</td>
<td>Adaptive Fast Charging</td>
</tr>
<tr>
<td>BC</td>
<td>Battery Charging</td>
</tr>
<tr>
<td>CDM</td>
<td>Charged Device Model</td>
</tr>
<tr>
<td>CRC</td>
<td>Cyclic Redundancy Check</td>
</tr>
<tr>
<td>HBM</td>
<td>Human Body model</td>
</tr>
<tr>
<td>OCP</td>
<td>Over Current Protection</td>
</tr>
<tr>
<td>OVP</td>
<td>Over Voltage Protection</td>
</tr>
<tr>
<td>OVT</td>
<td>Over Voltage Tolerant</td>
</tr>
<tr>
<td>PRNG</td>
<td>Pseudo Random Number Generation</td>
</tr>
<tr>
<td>RCP</td>
<td>Reverse Current Protection. Supported in Source configuration only.</td>
</tr>
<tr>
<td>SCP</td>
<td>Short Circuit Protection. Supported in Source configuration only.</td>
</tr>
<tr>
<td>SHA</td>
<td>Secure Hash Algorithm</td>
</tr>
<tr>
<td>TRNG</td>
<td>True Random Number Generation</td>
</tr>
<tr>
<td>UVP</td>
<td>Undervoltage Protection</td>
</tr>
</tbody>
</table>
Glossary

This section lists the most commonly used terms that you might encounter while working with PMG1 MCU family of devices in ModusToolbox™ software.

**Board support package (BSP):** A BSP is the layer of firmware containing board-specific drivers and other functions. The board support package is a set of libraries that provide firmware APIs to initialize the board and provide access to board level peripherals.

**KitProg:** The KitProg is an onboard programmer/debugger with USB-I2C and USB-UART bridge functionality. The KitProg is integrated onto most PMG1 MCU kits.

**MiniProg3 / MiniProg4:** Programming hardware for development that is used to program PMG1 MCU devices on your custom board or PMG1 MCU kits that do not support a built-in programmer.

**Personality:** A personality expresses the configurability of a resource for a functionality. For example, the SCB resource can be configured to be an UART, SPI or I2C personalities.

**Middleware:** Middleware is a set of firmware modules that provide specific capabilities to an application. This provide high level software interfaces to device features (e.g. PDStack).

**ModusToolbox™ software:** An Eclipse-based embedded design platform for developers that provides a single, coherent, and familiar design experience combining the driver libraries, middleware and the lowest power, most flexible MCUs with best-in-class sensing.

**Peripheral driver library:** The peripheral driver library (PDL) simplifies software development for the PMG1 MCU architecture. The PDL reduces the need to understand register usage and bit structures, thus easing software development for the extensive set of peripherals available.
## Revision history

<table>
<thead>
<tr>
<th>Document version</th>
<th>Date of release</th>
<th>Description of changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>2021-02-26</td>
<td>Initial release</td>
</tr>
</tbody>
</table>
| *A              | 2021-07-28      | Added **1.5 PMG1-S3 MCU** section  
Updated **Table 2** and **Figure 12**  
Added a note in **3.4.5**  
Added **3.4.7 Part 7: Debug the application** section |
| *B              | 2022-02-10      | Updated section **3.4.6 Part 6: Test your design** to describe the UART connection step on older revisions of the kit board |
IMPORTANT NOTICE

The information contained in this application note is given as a hint for the implementation of the product only and shall in no event be regarded as a description or warranty of a certain functionality, condition or quality of the product. Before implementation of the product, the recipient of this application note must verify any function and other technical information given herein in the real application. Infineon Technologies hereby disclaims any and all warranties and liabilities of any kind (including without limitation warranties of non-infringement of intellectual property rights of any third party) with respect to any and all information given in this application note.

The data contained in this document is exclusively intended for technically trained staff. It is the responsibility of customer’s technical departments to evaluate the suitability of the product for the intended application and the completeness of the product information given in this document with respect to such application.

For further information on the product, technology, delivery terms and conditions and prices please contact your nearest Infineon Technologies office (www.infineon.com).

WARNINGS

Due to technical requirements products may contain dangerous substances. For information on the types in question please contact your nearest Infineon Technologies office.

Except as otherwise explicitly approved by Infineon Technologies in a written document signed by authorized representatives of Infineon Technologies, Infineon Technologies’ products may not be used in any applications where a failure of the product or any consequences of the use thereof can reasonably be expected to result in personal injury.